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CAM350 设计校验培训 
课程大纲 

 
 
正确输出  Gerber, NC, 以及  Netlist 文件 
� Gerber 数据说明 
� RS-274d 和 RS-274x 
� 完全数据传送的输出提示 
�  Power PCB (如果必要) 
� Allegro (如果必要) 
� Orcad (如果必要) 

 Gerber 输入到 CAM350 
� 输入选项 
� 导入 RS-274d 和 RS-274x 
� 不能导入的 RS-274d 
� ARL 文件及其功能 

在 CAM350中比较 Netlist 
� 提取 Netlist 产生 Gerber 
� 把一个 IPC-d-356 Netlist 和从 CAM350 中提取出 Netlist 的 Gerber 文件做比较 
� 在 CAM350 中查看比较结果 

CAM350 中流(Stream)记录中的 DRC/DFM 
� 正确设置一个 “流(Stream)” 
� 设置并保存一个常用的 DRC 以运行检查所有的文件 
� 成功执行 DFF 分析的参数设置 

附加特性 
� 比较层 
� 泪滴 
� 清除丝印 
� 快速拼板模块 
� 层设置/埋，盲孔以及 MCM 技术 
� 编辑命令 

关于 IPC-2524; PWB 结构质量评价 
� 规格综述 
� 关键成分论述 

开放的讨论 
� 与客户互动讨论疑难
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Gerber 数据 
 
要理解 Gerber 数据的基本概念，首先要知道它的起源。当 RS-274 数据以及矢量光电绘图

仪被大规模使用，以及 RS-274X 和光栅绘图仪开始流行时，Richard Nedbal 写了这篇文章。 
DownStream Technologies 技术支持工程师认为，无论技术更新多快，这篇文章对 CAD/CAM 
的初学者来说，仍然是一本优秀的参考资料。 
 
基础知识 
 
术语“Gerber”一般用来表示“光电绘图”的图形数据的一种格式（RS-274, 274D, 或 274X）。

这种图形数据被用于创建一次一层的 PCB 布线图。最好先理解一下，Gerber 数据是如何被

创建，辨认以及使用的。越来越多的人员参与到设计印刷电路板的工作中来了。低成本的

光电绘图仪的出现，也使这些设计人员开始生产自己的布线图。 
 
从 CAD 系统到光电绘图仪的数据流程 
 
无论使用的是哪种 CAD 系统，都可以从内在的 CAD 数据库转换为 Gerber 格式。光圈表（定

义光圈大小，形状和位置）通常由用户提供。转换一般是在后台执行的，不可见。Gerber 格
式创建后，可以被光绘输出。要想知道转换和相关的步骤是否正确，必须等待输出的结果。

光电绘图仪是非常昂贵和精确的机器，可以产生比 1/8 mil 精确度更高的布线图。  
 
矢量光电绘图仪是如何工作的 
 
实际生产中有种类繁多的光电绘图仪。我们可以看一下那些典型的矢量机器光圈类型。虽

然现在这些型号大部分都已不再使用，它们仍然可以帮助我们了解 Gerber 文件，光圈表，

以及D码的起源。这种类型的光电绘图仪通过旋转光圈轮，来选择菲林上要曝光的图形。

然后它会打开和关闭遮光器。 通过光圈轮定位的光圈图形，就被闪现在文件上。术语“闪

现”意味着遮光器只是打开和关闭，什么都没有移动，图像就被闪现在菲林上。光圈在菲

林上移动时，如果遮光器保持打开，最初的光圈图形会被画在菲林上——不是闪现。画和

闪现的唯一不同点就在于，移动过程中遮光器是否打开。 
下面是用不同光圈图形画出的结果： 
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光圈轮是一个物理部件，每个轮在处理光圈的数量和尺寸时，都有一些实际的局限。

历史上，最大值为24。当然，光圈轮可以改变，但通常在光绘期间是不改变的。 

如果需要特殊的焊盘形状（比如泪滴），这种形状必须确实存在，或者必须制作出来。

特殊的形状几乎总是用于flashes（闪现）。有一种惯例，为flashes（闪现）预留出指定

的光圈位置，其它位置用于适合draw（画）的对称的形状。也倒不是没有提供flash旋转，

单独的光圈必须被用于不同的flash方向。 

画图形时，矢量光电绘图仪像针式绘图仪一样工作。遮光器关闭时，移动命令会决定光

电绘图仪的位置。这时，不画任何图形。然后，遮光器打开，光圈移动到下一个矢量位

置。如果线是连续的，光电绘图仪会继续工作，移动到下一个位置，然后再下一个。直

到光圈关闭，画线结束。 

转换 CAD 数据库到 Gerber 数据的 CAD 软件，必须要知道哪个光圈（它的位置）会包

含给定的光圈尺寸和形状 —— 比如 12 mil 直径的圆。得到的 Gerber 格式包含代码，

通过标号（比如光圈#13）选择合适的光圈，移动它到画图的开始位置，打开遮光器，

移动到下一个位置。使用者要自己确认 #13 位置的光圈轮上的光圈包含 12 mil 的圆的

形状。 CAD 系统没有办法知道，当前的光圈是错误的。光电绘图仪也不知道使用者

需要哪种形状。因此， CAD 用户必须提供给光电绘图仪操作者每一层的 Gerber 文件，

还必须提供光圈表，其中列出了相应尺寸和形状的D码的光圈数量。 
 
 
光圈表的例子如下： 
 
Photo-Plotter Apertures Report 
============================== 
Position  Width  Hgt/ID  Shape    Qty 
========  =====  ======  =====    === 
   12      0.024     0.09    OVAL     56 
   13      0.024     0.074    OVAL     80 
   14      0.06       0    SQR       6 
   15      0.05     0.118    OVAL      4 
   16      0.09       0    RND       2 
   17      0.17       0    RND       2 
   18      0.062       0    RND       4 
   19      0.12     0.09    RECT      4 
   20      0.035       0    RND     116 
   21      0.055       0    RND      26 
   43      0.01       0    RND     503 
   44      0.008       0    RND     469 
   45      0.012       0    RND      56 
   46      0.015       0    RND      11  
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一些典型的问题 

光圈表不匹配 

这个问题是显而易见的。有时候会出现光圈表和 Gerber 数据不匹配的情况。大多数 CAD 
系统处理画图的方式是不同的（下面我们会讨论这些），那么 flashes 就会出现问题。

比如，需要一个 60 mil 的正方形flash，光圈表中却调用了一个 40 mil 的圆形flash，结果

就是错误的。这是一个很常见的错误。 

多条线画图 

另一个问题，经常没有办法说出，CAD 数据库中的线宽是否有相匹配的光圈。通常情

况下，在 PCB 设计中，大多数线都是 12 mil 的线宽。 CAD 系统或者自动指定一个 12 mil 
的圆形光圈，或者从用户提供的光圈表中调用一个不同的 12 mil 的光圈。但是，如果用

户忘记指定 12 mil 的光圈怎么办？大多数系统仍然会尝试曝光一个 12 mil 的光圈。这

时，它会选择一个小一些的光圈，比如 6 mil的光圈，然后前后调整，直到达到需要的 12 
mil 宽的光圈。没有办法预知 CAD 系统如何创建需要的线宽。因此产生的 Gerber 文件

可能比原始数据大好几倍。这是因为系统做了“调整”，光绘的时间也相应地延长了。 

填充不规则的形状 

如果所有要处理的都是 5 mil 和 10 mil 的圆形光圈，那么怎样填充三角形的形状？尝试

过之后，会有这样的结论：能利用的最小半径为 2.5 mil （5 mil 的一半）。这样，三角

形的一些很锐利的点，都不可能做出来。在三角形的中心区域，您会选择 5 mil 光圈然

后敲打前进，还是会选择更大的 10 mil 光圈，只是在需要的时候才改变为 5 mil 光圈？

还有，不可能预测到 CAD 系统的 Gerber 转换软件将要做什么。更糟糕的是，假如光圈

表包含了一个 1 mil 的光圈怎么办？系统会自动选择最小的可用光圈吗？Gerber 文件的

大小是可怕的，光绘的时间也会非常的长，花费巨大。 

很明显，到现在， flashes 是非常有效率的光绘方法。它们在 Gerber 数据中，只占用很

小的文件空间，而且能很快地实现。即使有一些不规则形状的焊盘需要使用用户自定义

的光圈。不幸的是，有一些 CAD 系统不能很好地处理 flashes ，用户不得不使用线画出

不规则的形状。虽然这时光绘是正确的，仍然会有一些问题。比如多余的数据信息和过

长的绘图时间。有些光电绘图仪不能处理太大的绘图文件。 

光绘 Gerber 文件 

这里有一个简单的绘图例子，由两个 flashes 和一些 draws 组成。 
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 ASCII Gerber 文件是如何显示的 
 
G54D12* 
X15000Y9000D03* 
X15300Y9300D03* 
G54D13* 
X15300Y9300D02* 
Y9000D01* 
X15000D01* 
M02* 
 

发生了什么： 

关闭遮光器，选择光圈 D12 （50 mil 正方形） 
移动到 X=15.000, Y=9.000 & flash 焊盘 #1 （打开和关闭遮光器） 
移动到 X=15.300, Y=9.300 并且 flash 焊盘 #2 
选择光圈 D13 （12 mil 圆形） 
移动到 15.300, 9.300 并且遮光器关闭 
打开遮光器（开始 draw ）并且移动到 X=15.300, Y=9.000 （Draw 第一个线段）*** 
移动到 X=15.000, Y=9.000 并且遮光器打开（完成线）*  

***如果前一个坐标不改变，那么只需要一个坐标。 

Gerber 格式注意事项 

特殊的 D 码被指定为一些功能，比如“移动”和“ draw”，以及控制 D 码。 

一些例子： 

遮光器打开移动时：    D01 
遮光器关闭移动时： D02 
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Flash：   D03 
改变光圈：                 G54 
文件结束：   M02 
通常情况下， Gerber 格式使用 D 码而不是光圈号。光圈号和它的 D 码之间是一一对应

的关系。（D码代表了 Draft 编码）最好是在处理 Gerber 数据时，同时使用 D 码和光圈

号。因为 Gerber 格式会使用 D 码而不是光圈号。刚开始看起来有些奇怪，因为光圈号

是连续的，但是为它们指定的 D 码不是连续的。 

也有其它一些特殊的编码。G 码是光电绘图仪功能控制，比如选择新的光圈。M 码是混

合编码，比如文件结束。 

星号 (*) 通常用于分隔命令块，有些系统用回车键或者 $ 符号。 

如果要定义坐标下至 1/8 mil ，需要 5 个小数位。一般的 Gerber 格式是 3.5，这意味着 3 
个整数位和 5 个小数位。Gerber 文件不包含小数点，这样，15.000 在 Gerber 文件中显

示为 01500000。光电绘图仪会识别它实际上表示 15.000，因为我们告诉了光电绘图仪，

格式是 3.5。我们也必须定义是前导零还是后导零。 

Gerber 文件可以包含绝对坐标值或相对坐标值。绝对值模式定义了准确的坐标位置，而

相对值模式定义了和上一个位置的偏移量。必须告诉光电绘图仪使用了哪种模式，这样

才能正确地再现坐标。 

为了正确地绘图，也必须为光电绘图仪操作者提供光圈表。 

光圈表（比如绘图） 

Aperture # DCODE SHAPE Size X Size Y 

3         D12                Square           50     50 
4                  D13                Round           12                  12 
 
Data format: Absolute, 2.3 

当然，我们也许具有指定的所有 24 个光圈，但是光电绘图仪只使用 Gerber 文件中包含

的光圈。另外，每一个 Gerber 文件都有原始数据。实际的坐标和这个原始数据有关系。

如果 flashed 焊盘为特殊的形状，比如，圆环或者泪滴， Gerber 文件看起来是完全相同

的。但是，光电绘图仪操作者会在位置 #3 调用一个不同的光圈形状。另外，光电绘图

仪没有它正在 flashing 的尺寸和形状的概念，它只是按照 Gerber 文件中描述的那样去

做，使用其中的光圈。 

其它类型的光电绘图仪 

目前为止，我们知道了机械光圈矢量光电绘图仪。有许多其它类型。光圈宽度，高度，

或者直径可以是变量，和照相机类似。这是有用的，因为大多数形状都是圆形，正方
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形或者长方形。这种类型的光电绘图仪对于“变量光圈”叫做“VAPR”。特殊的形

状，比如热焊盘和泪滴，仍然是通过涂抹创建的。 

激光光电绘图仪 

当前最常用的和最流行的光电绘图仪是激光或光栅光电绘图仪。它们流行的原因，是因

为所有的东西都是软件控制的。软件的图形化的描述中描述了需要的尺寸和形状，它们

代替了物理光圈。它们没有光圈轮。这样，光圈形状的总的数量（理论上）是无限的

——当然，通常的最大值是50。输入的矢量，被光栅图像处理机（RIP）来处理，它会

创建存储器中的打印图像。所有数据被读取和处理后，图像被传送到菲林，就像激光打

印机一样。这些机器非常快，数据下载和光栅化的时间占了打印的大部分时间。光栅化

的灵活性和快速度使这种机器的价格很高。 

特殊的 Gerber 应用程序 

光绘打印前，可以很方便地查看将要得到的结果。快速光电绘图仪是很昂贵的。分辨

率越高，打印时间越长，这时只能等待菲林出来。即使是最好的光电绘图仪，也需要

半天的时间。如果数据有错误怎么办？必须更改它，再把它传送到光电绘图仪。 

使用同样的信息，可以预先查看光电绘图仪的工作步骤。如果速度是很重要的，为什么

不把它打印到屏幕上，使用桌面激光打印机呢？这就是 Gerber 查看软件和打印软件要

做的具体工作。可以猜测的到，检查打印本质上是做了光电绘图仪要做的事，但是做的

更快，并且使用了已拥有的打印设备。打印分辨率不如打印速度那么重要。针式打印 
Gerber 文件是可以的，但是用桌面激光打印机打印 Gerber 数据要更好一些。因为打印

软件仍然需要光栅化数据，那么只使用激光打印机并不会提高处理的速度。最好的解决

方法是为激光打印机配一个小的 RIP（光栅图像处理机） 。RIP 可以快速光栅化，打印

机可以做其它的工作。对于一个 8 ½英寸 X 11英寸的图像，一个 300 DPI 的打印机需要 
1~1.5 Meg RAM。这个 RAM 可以被方便地加到 RIP 卡中，这个卡可以插入到PC 中。打

印超过一页的内容，可以被自动缩放到页面，或者打印到多个页面。毕竟，我们不是要

得到工艺图，只是一个 Gerber 数据的精确表现。 

为什么不能在图形化编辑 Gerber 数据的时候，把缩放和移动功能添加进来呢，就像在 
CAD 系统中那样操作？我们不想列出一些乏味的数字，让阅读者认为编辑 Gerber 数据

是枯燥的哲学。因为原始的 CAD 数据库保持不变。我们不同意这个观点。但是，有些

时候，您没有其它选择。假如 CAD 系统的 Gerber 转换有一个 bug ，或者您无法使用 
CAD 系统，或者 CAD 系统和/或它的数据库文件丢失，以及当前的 Gerber 数据库不是

最新的。无论如何，都可以查看它而不编辑它。 
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高级  Gerber  格式  

这部分讨论了使用常用的 RS 274 格式。这些可选择的区域被改进了，比如可以在 
Gerber 文件中嵌入光圈定义，以及使多个层融合。这部分也详细叙述了如何通过光电

绘图仪公司修改和增强常用的 RS 274 格式。有一些常用的 274 格式的特殊对比，来说

明使用增强的格式的好处。每一种格式的问题和缺陷也都做了叙述。 

为什么需要负片数据？ 

普通的 274 格式创建于矢量光电绘图仪时代。这些机器非常精确，但是它们类似于

针式打印机。因为它们产生图像——不移动图像。一旦菲林曝光，就没有办法“反

曝光”。 

随着激光打印机的出现，我们就可以先把光栅图像存在存储器 里 ，然后再输出菲林。

这样，数据可以被定义为 ON 或 OFF 。转为 OFF 就会擦掉它。这个过程在曝光菲林之

前。因此，数据可以代表 dark（图像）或者 clear（擦掉）的结果。工厂里有几个术语，

比如 dark/clear, paint/scratch, 以及 draw/erase 。 

下面是一个简单的热焊盘的例子： 

 

矢量光电绘图仪 

在矢量光电绘图仪中，热焊盘是一个物理光圈，会以大得多的比例制造出来。开口的形状定义了

图像的形状。但是，这个工作很明显地被限制在特定的一些形状上。另外，必须在每个光圈轮上

安装每一个光圈，这样在打印时也限制了光圈的个数。通常情况下，最大个数为24。 

普通的 274 格式 

在普通的 274 格式中，负片数据不能表现出来。有些东西，比如热焊盘会以两种形式

反映出来：. 

1. 274 文件只包含 D 码位置（D44）。D44 被闪现后，实际上发生了什么，这取决于光

电绘图仪的操作者。他们也许在查看需要的 D 码的图画，利用光电绘图仪生产商提供的工具，

使用位图创建一个。我们没有办法知道他们是否使所有的东西都正确，直到检查菲林时才能知

道。当然，这个特殊的光圈只需要创建一次。随着时间的推移，操作者创建的光圈形状会越来
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越多。并且，因为没有“光圈轮”，几百个光圈都可以同时存储在存储器中。在这个工程中，

人为产生错误的几率是显而易见的。然而，现在大多数工厂都在采用这种方式，因为这样产生

的结果和位图一样好。因为所有的工作都是在光电绘图仪上完成的，设计者对这些问题毫无经

验。当然，设计者只好产生需要的形状的草图，在 Gerber 文件中包含光圈表。但是这个过程中

有可能会出现错误。 

2. 另一种方法，利用简单的，容易得到的形状画出需要的光圈形状。因此，要考虑的

是，一个单一的热焊盘实体被表现为四个单独的圆弧，但是每个圆弧的结尾是圆的！

可以画出光圈，但是，它节省的唯一的事情，就是在光电绘图仪上创建的时间，以及可

以预先知道菲林的内容。结果通常是不可接受的。 

增强的 274 格式 

如果假定总是使用激光打印机，如果也知道将要使用的光电绘图仪，那么我们可以用光电

绘图仪可以解读的方式定义负片信息。然后，我们可以用 ON/OFF 数据的组合方式画出需要的光圈

形状，把这个定义保存在Gerber 文件中。 

光电绘图仪读取这个文件时，关于如何表现光圈需要知道的所有信息都在这里了。实际上，我们

是用 Gerber 文件中包含的数据来对光电绘图仪编程。另外， CAM 工具应该允许我们预先看到 
WYSIWYG 检查和一个信息检验标记。 

通常如何处理负片信息 

反映 clear 或 scratch 的数据位于两个地方：也许用于自定义的光圈，但是也可以用于层

数据，比如 pad shave 或者在电源层的埋线。两种方式不是必须同时处理的，它可以得

到复杂的，因为没有两个光电绘图仪使用相同的步骤。274 扩展没有通用的标准。只是因为 Gerber 
使用 274X ，这并不意味着其它光电绘图仪可以读取 274X 文件。 

负片数据如何用于创建真实的自定义形状 

下面的几个例子，叙述了 274X 格式如何使用负片或者 ON/OFF 数据指定光圈形状。 

自定义光圈宏语句  

自定义光圈信息包含在 % 分隔符之间。光圈名称会立即跟随光圈宏。每个光圈宏命

令以 * 分隔。 

基本的 

ON = 1 (dark), OFF = 0 (clear) 

圆 
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1, ON/OFF, diameter, xcenter, ycenter 

Line-矢量（有宽度和终点的线） 

20, ON/OFF, Width, xbegin, ybegin, xend, yend, rotation 

Rectangle -Center （由中心和直径定义的长方形） 

21, ON/OFF, width, height, xcenter, ycenter, rotation Rectangle-Lowerleft (a 

rectangle defined by a lower-left corner coordinate and dimensions) 

22, ON/OFF, width, height, xlocation, ylocation, 

rotation Outline (a sequence of points) 

4, ON/OFF, count, X, Y, X, Y, X, Y,&ldots;.., 

rotation Polygon (a closed, filled shape with 

equal length sides) 

5, ON/OFF, number, xcenter, ycenter, diameter, 

rotation Moiré (a moiré pattern) 

6, xcenter, ycenter, OD, line_thickness, gap_thickness, number_of_circles, 
crosshair_thickness, crosshair_length, rotation 

例子  

100 mil 圆环有 50 mil 的孔 

%AMDONUT* 
1, 1, 0 . 
10000, 0, 
0* 
1,0,0.050
00,0,0* 
% 
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125 mil 热焊盘有 80 mil 的孔以及 4 个交叉的结，每个的宽度为 25 mils 

这个特殊的自定义光圈有一个很长的名字，这样也许可以有助于记忆具体是什么光圈，

但是这种格式没有其它意义（只是一个名字）。 
 

%AMTHERMAL_OD=125_ID=80_GAPS=4_WIDTH=25* 
1,1,0.12300,0,0* 
1,0,0.08000,0,0* 
21,0,0.12500,0.02500,0,0,45.00000* 
21,0,0.12500,0.02500,0,0,135.00000* 
% 

 

填充的五边形，直径 100 mils ，有一个 40 mil 的孔 

%AMPENTAGON_D=100* 

5,1,5,0,0,0.10000,0* 

1,0,0.04000,0,0* 

% 
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90 mil 八边形，有一个 40 mil 的菱形孔 

%AMOCTAGON_90_DIA40* 
5,1,8,0,0,0.09000,-22.50000* 
21,0,0.04000,0.04000,0,0,45.00
000* 
% 

 

负片数据如何用于创建合成图像 

为了在电源层上走线，必须把几个层组合以产生正确的层。这个层叫做复合层 
（Composite Layer）。通常，第一层被翻转，然后第二个 clearance 层用于打开路径，

然后，走线层用于实际的连接。标准的 274 格式不直接支持这个过程。 
 
通过几个简单的步骤来产生复合层： 
创建需要的层。如果电源层上有走线，必须要创建 clearance 层。使用 CAM 工具可以简

单地对已有的数据做 oversizing （加大） 
决定需要的层的顺序，包括最初的背景。 
选择光电绘图仪格式，使用 CAM 工具创建图像。 
最好查看一下组合后的结果，打印前先创建一个检查打印标记。 

274X Gerber 格式的例子 

所有标准的 274 特征都保留在 274X 格式中，而且添加了新的性能。这里有一

个 274X 文件的例子： 

 
%FSLAX23Y23*% 
%IPNEG*%%MOIN*% 
%AMTH7550E* 
1,1,0.075000,0.000000,0.000000* 
1,0,0.050000,0.000000,0.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,45.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,135.000000*% 
%ADD10C,0.010*% 
%ADD11C,0.030*% 
%ADD12C,0.050*% 
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%ADD13C,0.060*% 
%ADD14C,0.080*% 
%ADD15TH7550E*% 
%LNXPLANE.GBR*% 
%LPC*% 
G54D13* 
X0Y100D03* 
X300D03* 
Y0D03* 
G54D15* 
X0D03* 
G54D11* 
Y200D02* 
G01X300D01* 
G54D14* 
X0D03* 
X300D03* 
G54D13* 
X0Y300D03* 
X300D03* 
%LNXTRACE.GBR*% 
%LPD*% 
G54D12* 
X0Y200D03* 
X300D03* 
G54D10* 
X0D02* 
X300D01* 
M02* 
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274X 格式描述（使用上面的例子） 

%FSLAX23Y23* % 

FS = 格式综述，L = 前导零抑制,  A = 绝对坐标, X23 & Y23 = 2.3 格式 (X and Y 可以使用

不同的分辨率)。 

%IPNEG* %%MOIN* % 

IPNEG = 设定最初的背景为 dark. 
MOIN =  模式被设置为英寸（inches） 
请注意，一行可以包含多个命令，只要每个命令以 % 符号分隔开。 

%AMTH7550E* 
1,1,0.075000,0.000000,0.000000* 
1,0,0.050000,0.000000,0.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,45.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,135.000000*% 

 

  

定义热焊盘自定义光圈 

%ADD10C,0.010*% 
%ADD11C,0.030*% 
%ADD12C,0.050*% 
%ADD13C,0.060*% 
%ADD14C,0.080*% 
%ADD15TH7550E*% 

 
ADD14C,0.080 = 80 mil 圆 (圆) 指定为 D 码 14. AD 指定光圈为 D 码位置。 
 
%LNXPLANE.GBR*% 

层名称 (XPLANE.GBR) 指定为复合层的第一层。 

%LPC*% 

LPC = 层的极性为 clear. XPLANE.GBR 上的数据表现为 clear. 
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G54D13* 

G54 选择 D 码, D03 = flash , D02 = 移动 D01 = draw. 

X0Y100D03* 
X300D03* 
Y0D03* 
G54D15* 
X0D03* 
G54D11* 
Y200D02* 
G01X300D01* 
G54D14* 
X0D03* 
X300D03* 
G54D13* 
X0Y300D03* 
X300D03* 
%LNXTRACE.GBR*% 

层名称 (XTRACE.GBR) 指定为复合层的第二层。 

%LPD*% 

LPD = 层极性为 dark. (XTRACE.GBR 上的数据表现为 dark.) 

G54D12* 
X0Y200D03* 
X300D03* 
G54D10* 
X0D02* 
X300D01* 
M02* 

M02 = End of line. 
 

关于复合层的更多内容 

复合层传统上在 CAM 程序中是有问题的。很多人仍然认为，或者把一个 Gerber 文件分隔

为多个文件，或者在背景中完成这些操作，并把这些隐藏起来。这样做的问题是，没有一

个真正的单一的文件，DRC 和 Netlist Compare 不能正确地执行。这个论断在现在的许多 
CAM 程序中非常流行。 
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许多程序有一些工具，可以转换复合内容为一个层，但是不能保留 flashes 和 draws。相反，

创建了一些多边形 （polygons）。这个也是有问题的，使用者不能容易地修改数据。 

CAM350 在复合层方面不存在问题。它会在 Gerber 输入时把它们分解到一个单一的文件。

注意：这个功能默认情况下是没有激活的。如果用户看到许多复合文件，可以进入 
File/Setup/Photoplotter，选择 RS-274x 选项，然后在这个对话框中，激活选项“Convert 
Composite to Single Layer”。程序会提示要进行保存。如果保存，所有产生的复合内容会

被分解到单一的层。 

光圈如何被嵌入到文件中 

上面的例子叙述了数据如何保存在合成的 Gerber 文件中。注意有两个部分： AM 部分定义

了光圈是什么，AD 部分指定了光圈到 D 码。圆和正方形是基本的，不需要非常复杂的定

义。 

如何自定义光圈和使用它 

AM 部分使用前面的语法定义了每个自定义的光圈。 

%AMTH7550E* 
1,1,0.075000,0.000000,0.000000* 
1,0,0.050000,0.000000,0.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,45.000000* 
21,0,0.078000,0.020000,0.000000,0.000000,135.000000*% 

AD 命令指定这个光圈到一个 D 码。在下面的例子中，名称为 TH7550E 的自定义光圈被指

定到 D 码 D15。 

%ADD15TH7550E* % 

实际的值（比如 .075）可以用变量，比如 $1 或 $2 来替换。这样允许 AM 部分来定义一个

常用的自定义光圈，它的值随后会用 AD 命令输入。每一次使用 AD 时，可以再次改变值。

这样会很混乱。因为 D15 在整个文件中，可以不是同样的形状。但是这样灵活性就提高了。 

如何处理层极性 

关于层极性有两个论点。第一个是通过 IP 命令定义的开始背景。第二个是数据如何被反映

出来。 IP 命令定义了开始背景或者为 dark ，或者为 clear。所有下面的 LP 命令定义了给定

层上的数据如何被反映出来，忽略前面的 IP 状态。另一种说法是 LP 是绝对的，不倚赖于 IP 
命令。 
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274X 格式的好处和缺陷 

274X 格式的最大好处就是，不同层的复合内容变为只有一个文件，无论创建它时用了多少

个层。这样可以使文件中嵌入的光圈部分非常容易理解。另外，不复制文件，就不会丢失

任何需要的信息。所有需要的内容都包含在文件中。 

274X 格式有一些显而易见的好处，比如有嵌入的光圈，在 CAM 状态 WYSIWYG 查看，

简单的文件管理。也还有一些其它的好处，比如可替换型 AM 参数。这样允许初学者去定

义。但是它的实际尺寸可以在文件内按照需要多次改变。 

优点： 

 
• 光圈宏定义和使用非常灵活 
• 没有单独的宏文件——所有内容都在一个文件中 
• 不需要基本的光圈宏 
• 自定义光圈可以包含负片数据。一个简单的步骤和重复命令 
• 简单的光栅多边形填充命令 

 
 

总结： 
 

• 激光打印机或光栅打印机当前是最流行的 
• RS-274x 是首选数据格式 
• 十进制精度时，英制单位最少使用 3.5  
• 十进制精度时，公制单位最少使用 3.5 
• 分解复合内容时，转换复合内容到一个层选项需要激活 
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Power PCB (PADS Layout) 输出提示 
 
1) 如果使用了 augment，那么在输出 Gerber 文件之前，要点击 regenerate 以确保闪

现终点。  
2) 使用 offset 作为默认设置确保所有的层都对齐。对钻孔文件也使用同样的 offset 
距离。 
3) 在钻孔文件的 device setup 对话框中，Format String 中，见下图。这样确保钻孔文

件是“合法的” Excellon data. 
 

 
 
4) 应该使用 RS-274X 格式。 
5) 对 Metric and Imperial 单位，优先选择 3.5 精度。 
6) 通常 G36/G37 和光圈宏是不需要的。 
7) 对钻孔文件的 Gerber 输出，使用同样的精度。 
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8) 在直接的 CAM link，使用所有的默认设置。如果进入 Tools/NC Editor，然后到

Utilities/Create Drill （在 CAM 350 中），接受默认设置，却不会得到钻孔文件。钻

孔文件会从 padstack 数据创建。 
 
 
 

 
 
 

从 PADS Layout 产生的 IPC-d_356 Netlist 
 
有三种方式从 PADS 创建 IPC-d-356 Netlist。PADS 没有 IPC Netlist 输出。但是可以使用 
CAM350 产生输出。在线也有一个 script 用于产生输出。 
 

• 使用直接 CAM 方式：在 PADS Layout 中，转到 Tools/CAM350。参考下图正确设

置。同时在 CAM350 中，转到 File/Export/Netlist 再选择 IPC-d-356 格式。 
 

• 使用 ASCII 输入方式：在 PADS Layout 中，输出 ASCII 文件。在 CAM350 中，

File/Import/CAD data 并选择 Power PCB 选项。输入文件，然后转到 File/Export/Netlist 
再选择 IPC-d-356 格式。 

 
• 使用不支持的 script。下载地址  http://www.designsystems.fi/downloads-english.htm   
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Allegro 输出提示 
 
 

1) 下面的两个图形列出了钻孔文件的设置。 
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Orcad 输出提示 
 
 

 
1) 输出 IPC-d-356 Netlist 时，在输出格式下，选择 Fixed length records with linefeed。 
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输入 Gerber Data 
File Import Autoimport 
 
我们从客户那里得到的 Gerber 文件经常只有很少的相关信息。这会导致 CAM 操作者浪费

很多时间去猜测文件的格式（274D, 274X, Fire9xxx, Barco, 等等）和精度  (2.3, 2.4,???)。
Autoimport 命令被创建为通用的 Gerber 输入方式，哪些是和 Gerber 相关的文件，取决于

我们多年处理 Gerber 数据的经验。有了这个命令，这个大大提高操作者的效率。 

Autoimport 会自动读取和输入所有系统可以输入的非 CAD 文件类型： Gerber, HPGL & 
HPGL/2, DXF, IPC-D-350, 等等。如果是 Gerber 数据，它决定了正确的格式和参数。命令也

可以自动检测和转换光圈文件。通用的光圈转换器也可以转换输入的 Gerber 数据。 

请注意：用 Autoimport 输入 Gerber 时，不能对任何输入的非 274D 格式的 Gerber 文件

显示 Mirroring 或极性选项（如果有使用）。 

命令顺序： 

1. 把所有属于同一个工作的文件放在一个文件夹中。在 AutoImport 过程中，可以选择不

输入某些文件，但是系统会分析每一个文件，来决定文件的格式。如果文件夹中没有

多余的文件，会节省很多时间。 

2. 选择 File > Import > AutoImport. 出现 AutoImport Directory 对话框。 

3. 如果知道数据格式是 RS-274d ，选择文件是 English 还是 Metric 单位。 
 
4. 如果知道数据精度有多种格式，选择 “Scan each Gerber”.  

注意：如果有必要，也可以从下一个窗口返回到这个步骤。 

5. AutoImport 会显示选中文件夹中的文件。要选中目录文件夹，不是文件。 

6. 点击 Next. 这时屏幕上显示要识别的文件，以及这些文件的格式。也可以选择要输入

哪些文件，不输入哪些文件。 

7. 对于 RS-274x Gerber 文件： CAM350 会读取标题外的格式信息，并在下一个屏幕上

显示出文件类型和文件格式。光圈文件也会被识别出来。它们在输入 RS-274x 时不是

必须的，也可以不选中。钻孔文件的默认精度为 2.4 （对 English units）和 3.3 （对 Metric 
units）。其它格式需要手工输入。钻孔报告文件也可以被识别，可以选中它。 

8. 对于 RS-274d Gerber 文件： CAM350 会决定精度，零压缩（zero suppression）和坐标

类型。光圈文件也会被识别。它们会显示在下一个屏幕上，同时还有合适的转换 (.arl 
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file)。再点击 next ，会显示出 CAM350 创建的 Gerber 文件和光圈表之间的联系。 （例

子： art01.pho-art01.rep） 可以改变这些联系或接受 CAM350 决定的联系。 

常见注意事项： 

1. 在 AutoImport 对话框中，检测到的文件类型会在下一个输入文件中显示出来。也可

以改变这些文件类型，但是有可能导致输入不正确。 

2. 对于任何检测到的 Gerber 文件，格式会显示出来。如果点击格式按钮，会显示出更多

的细节（也可以编辑）。如果文件在 Type 列中没有标记为 Gerber 文件，则格式显示

为 "N/A" ，也不能改变它。 

3. 在 Import （输入）列，系统可以输入的文件都有一个检查标记。如果要在输入过程中

添加或删除文件，可以在这里选择。 

4. 如果输入 274D 格式的文件，并且输入了多个光圈文件，会出现指定光圈文件对话框。

这里会列出光圈文件，以及相关的 Gerber 文件。每个 Gerber 文件旁边，列出了当前

指定的光圈文件。要改变这些指定，可以点击一个光圈文件，然后再点击要对应的 
Gerber 文件。如果有必要，可以重复这个步骤，直到每个 Gerber 文件都有对应的光

圈文件。点击 Finish 完成。系统会根据每一个可用的 .ARL 文件来检测光圈文件。第

一个通过的 .ARL 文件会成为光圈格式。层的样式现在显示在屏幕上。 

常见问题： 
      

输入 Gerber 数据时大多数产生的问题主要在三个方面： 
 
光圈不正确 

输入 274D 文件时，最常见的问题是光圈不正确或者丢失 .ARL 文件。系统会在当前的

目录下所有的 .ARL 文件中检测每一个光圈文件。这些 .ARL 文件必须是正确的（少于 
15% 读取错误），并且在输入时位于当前的文件夹中。 
 
一些光圈文件中，以不连续的方式定义了一些自定义的形状和热焊盘。这些光圈不能被

读取，从而产生的错误超过了 15% 的限制。所有错误都会记录在当前文件夹中，和光

圈文件同名的 .ERR 文件中。 

不正确的 Gerber 格式 

Gerber 文件只包含没有小数点的数字。一个数字，比如 X12345 可以是 1.2345 英寸，

12.345 英寸，或者 123.45 英寸。为了避免混淆，系统先假定数据的大小也许会大于 2 英
寸而小于 20 英寸。因此，系统会推断出 X12345 是 2.3 格式。如果所有的文件都显示太

大或太小，就需要再次开始输入的过程，为文件选择更合适的格式。 
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如果不选择 Scan Each Gerber （扫描每一个 Gerber ）选项，并且文件中使用了不同的

格式（比如 2.3 和 2.4），那么结果就是有些文件显示正常，而有些文件因为使用了

不正确的 Gerber 格式显示不正常（和其它的相比，光圈或者显示太大，或者太小）。

如果出现这种情况，就需要再次开始输入的过程，选择 Scan Each Gerber。 

不正确的层顺序 

层会以它们显示的顺序被输入。 
 

Edit > Layers > Reorder 命令允许数据在输入后，快速改变层的顺序。 
 
不正确的 Drill 格式 
 
自动输入钻孔被写入 Excellon 规格。这种规格需要所有的钻孔文件或者是 2.4 English 或者

是 3.3 Metric。在现实生活中，这种精度是不使用的，或者不是所需要的。钻孔文件常见的

十进制精度是 3.5 English 或 Metric。 
 

通用的光圈转换 
RS-274 (RS-274d) 数据需要转换以便程序（比如 CAM350）读取。每一个 CAD 供应商都使

用不同的格式来描述光圈。这些光圈表作为单独的文件，和 Gerber 文件一起输出。它们和 
Gerber 文件是相对应的。要正确地读取这些光圈表，必须为每一种格式单独编写一个翻译

器。这样，要跟上每一种格式的更新变化是很困难的。有时候，如果有不支持的格式（如

果这种格式不流行，也许永远都不会支持），必须等待很长时间去编写翻译器。需要一个

更好的办法：选择编写一个通用的，自定义编程的光圈表转换器。这样，用户可以根据自

己的需要来编写转换器。 

如果因为光圈格式不能辨认导致 RS-274d 文件不能输入，有两种方法： 

1) 年费期内客户可以发送文件和光圈表到 support@downstreamtech.com 相关技术

人员会为您编写一个可以翻译这个文件的 .arl 文件。 

2) 自己编写 .arl 文件，帮助信息中有很多相关的内容和例子。 

3) 输入光圈。一般不要用这种方法，因为有可能输入错误的尺寸。 

 
RS274 格式中，Netlist Comparison (比较网表)对于任何数据都是至关重要的。

它能确保转换过来的数据没有短路或开路。 
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层对齐 
 
这个命令可以对齐设计中指定的层到基本层中的一个对象。 
 

1) 打开参考层。 
2) 选择 Edit /Layers/Align. 光标变为对象捕捉光标。 
3) 选择参考层（所有层要对齐的相关对象都在上面）上的一个对象。 
4) 右键点击，确认这个对象，以及这个层为参考层。 
5) 打开要对齐的层。 
6) 点击要和参考对象相对齐的对象，点击右键确认。 
7) 继续选择对象，对齐其它的层。 
8) 完成操作后，右键双击两次，这时会对齐层并结束命令。 

 

 
 
 

在 CAM350 中比较网表 
 
 

1) 输入 Gerber 文件和钻孔文件 
2) 检查层是否对齐，如果没有就对齐它们（使用 Edit/Layers/Align） 
3) 输入 IPC-d-356 网表（Netlist） 
4) 检查网表的位置是否和 Gerber 以及 Drill 一样。使用 Settings/View Options/View 

输入的网络。如果有必要，移动 Gerber 和 Drill 到网表位置。位置检测完成后，

关闭外部网表的显示。 
5) 在层的指示条上用不同的颜色来校验 End Points 都被 flashed。如果它们没有被 

flashed，使用 Utilities/Draw 来交互地 Flash 加以转换。 
6) 使用 Utilities/Netlist 提取来产生 Gerber 网表。选项默认是关闭的。 
7) 转到 Analysis/Nets/Compare External Nets 来比较两个网表。 
8) 错误会显示在错误控制栏中，可以点击一个错误选项来查找具体的错误位置。 
 
大多数情况下，和 IPC-D-356 网表做参考的外部网表产生的一些常见错误： 
 
1) 短路 – 外部 Netlist 中的两个或更多网络在提取出 Netlist 的 Gerber 文件中连

接在一起。 
2) 开路 – 外部 Netlist 中的一个网络在提取出 Netlist 的 Gerber 文件中被分割为

多个网络。 
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3) 没有铜皮 – 外部 Netlist 中的一个点，在提取出 Netlist 的 Gerber 文件中没有

铜皮。 
4) 点上有多余的外部网络 –外部 Netlist 中的一个点，在提取出 Netlist 的 Gerber 

文件中没有网络。这个点上没有铜皮。 
5) CAM 网络中丢失外部网络 – Gerber 文件中提取出了网络点，而外部 Netlist 中

没有相关的点。 
 

Netlist 比较也可以在 Streams RC checklist 中完成。请参考说明中的 Streams Rules Overview
（综述）。 
 

Apply Nets 
 
Apply Nets 命令用于重新命名提取网络的 Gerber 文件。命名是在输入的外部 Netlist 的基础

上，通常是 IPC-d-356 Netlist。这样会为提取 Netlist 的 Gerber 文件中的网络命名，比如 GND，

或 VCC。这是为原始的 Gerber 层和网络添加智能属性的一种方法。 
 

从 CAM 网络更新外部网络 
 
这个命令主要用于裸板生产设备。它允许提取出 Netlist 的 Gerber 文件另存为外部 Netlist 或
参考 Netlist。如果这么做，提取出 Netlist 的 Gerber 文件可以在加工过程中和它比较。这可

以确保影响网络的错误可以在打印菲林前被发现，这些错误不会被制造出来。 
 

创建一个 One-Up Border 
 
Panel Editor 允许您为上一级设计加一个边框，使用设计中的边框层作为间距边框。这可以

确保能够精确地加边框。在提供真实的边框边缘的 streams 中分析的过程中，也可以使用

上一级边框。也允许设计者在分析时忽略边框外的区域，比如 title blocks。 
 
这个命令允许您转换已有的线，圆弧或其它画图数据到设计的上一级边框。在添加边框，

执行 step & repeated 时，这个边框在 Panel Editor 中作为一个间距外框。另外，它也可以作

为 venting border 来使用，防止 venting 影响图像。 
 
命令顺序： 
 
选择 Utilities/Draw To One-Up Border. 
 

1) 选择要转换到上一级边框的画图数据上的一个点。这个命令会高亮选中的数据。 
2) 如果要添加更多的线段，比如，添加到边框，可以选择要添加到边框的新数据中
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的一个点。 
3) 如果偶然在边框上选中了不需要的线的一部分，可以再选择它一次，就可以取消

选择它。 
 

或者 
 

添加边框 
 
这个命令会在 CAM Editor 中为任何上一级设计添加一个多边形边框。这个边框可以在 
Panel Editor 中使用，在分布重复图像加边框时，作为一个间距外形。另外，它也可以作为 
venting border防止 venting 影响图像。作为多边形，您可以把边框画成任何需要的形状，以

便更好地满足设计控制的需要。 
 
命令顺序： 
 
选择 Add /Border。鼠标指针变为一个选择点，可以去选取多边形线段上的点。 
 

1) 点击选择边框上的第一个顶点（vertex）。 
 

2) 移动鼠标指针，点击选择其它需要的顶点。 
 

3) 创建了需要的边框后，点击鼠标右键，结束创建边框的操作。边框会自动闭合到

选择的第一个点。 
 
 
 
 
 
 

Streams 规则检查：概述 
  

Streams 规则检查功能允许您为了重新使用复合印制电路板设计而定义 DFF 和 DRC 规则

检查配置。Streams 规则检查功能允许您组合 DFF 规则检查，DRC 规则检查，CAM350 宏
和不同的命令操作，对印制电路板的生产规则校验来创建批处理配置。Streams 规则检查提

供高级的用户界面支持，在其中可以进行 “drag-and-drop（拖、放）”规则设置，以及结

果预览。 
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对于 Streams 规则检查，每一个 DFF/DRC 规则配置叫做一个 Stream。 Stream 包含一个或

多个层类型检查的组。一个层类型检查包含多个预先定义的检查，它们都和特定的层类型

相关。在 Streams 规则检查中支持的层类型检查包括：信号层，正片层，负片层，Solder Mask, 
Silkscreen, 以及 NC Data 层。另外，也支持对于任意层类型的特殊检查和网表（Netlist）比

较检查。设计独立规则规范允许定义相同的规则，不管设计中有多少层和多少种层类型，

规则都会起作用。 
 

命令顺序： 
使用 View > Streams Rules Check 命令可以打开 Streams Rule Check 对话框，在这里可以创

建一个新的 Stream。 
使用 Streams List 对话框添加一个新的 Stream。在 Streams List 对话框中，可以管理已有的 
Streams 和全局的 Streams 选项。在 Stream 对话框的 Checks 标签（位于窗口的下方）上可

以设置 Stream。在 Checks 标签中，通过添加层类型检查来创建 Stream 定义。然后可以在 
Details 标签中选择详细的检查参数。Details 标签允许激活或不激活对层类型检查时的检查

程序。 
 
注意：可以使用 Areas 标签指定命名区域，它们可以重新作用于在 Stream 中指定的在任意

层类型检查中的限制规则检查。 
 
在 Run 图标的下拉列表中，选择一个执行选项，在 Streams 对话框中的 Checks 标签中运行 
Stream 。 
 
要运行 Stream 可以： 
(1) 不更改 Stream 定义参数运行 Stream  
(2) 在印制板边框内的区域运行 Stream  
(3) 在整个环境中运行 Stream （CAM350 工作区域）  
(4) 在用户指定的窗口运行 Stream 以便在运行时交互指定 
 
使用 Stream 对话框中的 Results 标签来分析 Stream 执行的结果。Results 标签储存了每次运

行执行后产生的错误信息。Results 标签中，按照执行的日期/时间，层检查类型和检查程序

类型，以树状浏览结构形式显示出执行的结果。选中错误时，图形窗口会缩放到相关的区

域，并高亮选中的错误。使用 Chart 图标显示选中错误的柱状图。在表中，鼠标移动显示

和 right mouse bottom 命令支持错误分析。使用命令 Info > Report > Streams Results 可以显

示执行结果报告。 
 

View > Streams Rules Check 
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View > Streams Rules Check 会打开 Streams List 最上端的对话框。Streams List 对话框用于

管理在当前数据库中定义的 Stream DFF/DRC 规则计划。 
 
注意：View > Streams Rules Check 命令可以打开或关闭 Streams List 对话框。 
 
命令顺序： 
 
选择 View > Streams Rules Check 
在 Streams List 对话框中，选择一个已有的 Stream Rules Check 或使用添加 Stream 图标，

为 DFF/DRC 计划添加一个新的 Stream Rules Check。 
 
选中一个 Stream，可以使用 Delete Stream 图标删除它。 
 
选中一个 Stream，可以点击 Stream 名称左边的“眼睛”图标，在 Stream 对话框中控制它

的可见性（显示或不显示）。 
 
要重新命名一个 Stream，可以双击系统定义的 Stream 名称并输入新的名称。 
在 Streams List 对话框中，使用 Export Streams 图标，可以保存所有已定义的 Streams 为一

个外部文件。也可以使用 Import Streams 图标，从外部文件输入 Streams。 
要设置全局的 Streams Rules Check 选项，可以点击 Streams List 对话框底部的 Options 标签。 
 
要在 Stream Results 标签输出中重新安排列的顺序，可以选中 Reset Loaded Column Order 检
查框。 如果不选中它，用户自定义的列顺序会保留在 Streams Results 标签输出中。 
 
要在检查区域定义期间激活选中的区域，可以选中 Animate Selected Areas 检查框。 
 
要设置 Stream 标签对话框的默认位置，可以点击 Stream Default Placement 行的“Value”
列，然后从下拉列表中选择相应的位置。 
 
要设置每一个 Stream 执行时检查到的错误的最大数量，就点击 Max Errors to Find 行的

“Value”列，并输入需要的最大错误数量限制。 
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创建一个 Stream 
  
一个 Stream 就是一套层类型检查，根据生产规则来检测设计。Stream Rule checks 可以按

设计独立习惯指定，以便 Stream 可以被应用于不同的设计文件。要创建一个 Stream 需要

两个主要步骤。第一，在 Stream List 对话框的最上端创建和命名一个 Stream。第二，为相

应的检查程序设置层类型检查和工艺生产参数。 
 
命令顺序： 
使用 View > Streams Rules Check 命令，从 Streams Rule Check 对话框创建一个新的 Stream。

在 Streams List 对话框中添加一个新的 Stream。在新的 Stream 行的左边，选择“眼睛”图标

使 Stream 可见（显示出来）。Stream 标签对话框会显示在程序窗口的底部。 
 
提示：可以在 Streams List 对话框中管理已有的 Streams 和全局的 Streams 选项。 
在 Checks 标签中使用 Add New Check 图标可以在新的 Stream 中添加层类型检查。支持的

层类型包括：Signal Layer, Positive Plane, Negative Plane, Solder Mask, Silkscreen, 和 NC Data 
Layer.另外，也支持对任意层类型的特殊检查和 Netlist Comparison （比较网表）。 
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针对 DFF 和 DRC 检查的层类型检查组检查程序，通常用于指定的层类型。 
 
提示：在新添加到 Stream 中的 Name 处双击，可以重新命名层类型检查。 
 
提示：检查执行的顺序是按照 Check 标签中检查排列的顺序。通过“拖、拉”当前的层类

型检查，可以容易地重新排序。 
 
CAM350 宏脚本和暂停命令可以被添加到 Stream 执行中。 
 
在 Checks 标签中，使用“Export Stream”图标可以把 Stream 定义保存到一个外部文件。

使用“Import Stream”图标可以从一个外部文件输入一个已存在地 Stream 定义。 
 
提示：在 Stream Lists 对话框中 (View > Streams Rules Check)，设计中的所有 Streams 都可

以从外部文件导入或导出为外部文件。 
在 Stream 对话框中的 Details 标签中，可以设置检查程序参数。在 Details 标签中，层类型

以树状结构分组。点击相应的行中的“Value”区域，可以指定层类型检查参数。 
 
提示：点击绿色箭头，可以激活层类型检查或激活单独的检查程序。 
 
Name – 在 Value 区域内点击，为层类型检查输入新的名称。 
Layers -在 Value 区域内点击，再点击 Value 区域右边的省略号 ("...")，打开层选择对话框；

先列出的是特殊的设计层，后面是用于设计独立的 Stream 设置的普通的层类型。 
Drill Layers - 在 Value 区域内点击，再点击 Value 区域右边的省略号 ("...")，打开层选择对

话框；先列出的是特殊的设计层，后面是用于设计独立的 Stream 设置的普通的层类型。 
DFF Checks – 这里列出了对这个层类型检查的检查程序的一个不可编辑的概要。 
DCODE Filter - 在 Value 区域内点击，再点击 Value 区域右边的省略号 ("...")，打开 DCODE 
filter 对话框。在下拉列表中，选择 Dcodes 所在的层，再从这个层类型检查中选择需要的 
Dcodes。 
NC Tool Filter - 在 Value 区域内点击，再点击 Value 区域右边的省略号 ("...")， 打开 NC Tool 
filter 对话框。选择在这个层类型检查中需要的 NC Tools。 
Check Region - 在 Value 区域内点击，再点击 Value 区域右边的省略号 ("...")，打开 Area 
Selection 对话框。从预先定义的区域中，选择正片和负片区域，为这个层类型检查创建检

查程序要运行的复合区域。更多信息，请参考 Stream Area Check Regions 。 
Auto Fix Errors – 选中 Auto Fix Errors 检查框，激活程序自动修复 DFF 错误功能。 
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Details – 这是在这个层类型检查中可用的检查程序的树状浏览表。关于可用的检查细节，

请参考 Stream Rules Checks。 

 
  

Stream 检查程序 
  
在 Streams Rules Check 层类型检查中，有以下的检查程序： 
 
Signal Layer 
Track to Track, Track to Pad, Pad to Pad, Pad to Drill, Minimum Track, Minimum Pad, Unplated 
Drills to Copper, Plated Drills to Copper, Copper to One-Up-Border, Redundant Pads, Plated 
Drills without Pads, Pads without Drills, Antennas, Minimum Gap, Minimum Width, Acid Traps, 
Copper Slivers, Pin Holes 
Positive Plane 
Plated Drills to Copper, Unplated Drills to Copper, Pads to Drills, Acid Traps, Copper Slivers, Pin 
Holes, Minimum Gap, Minimum Width 
Negative Plane 
Plated Drills to Copper, Unplated Drills to Copper, Pads to Drills, Copper to One-Up-Border, 
Isolated Thermal, Starved Thermal, Thermal Conflict, Tie Width 
Soldermask 
Pad to Mask, Drill to Mask, Mask Slivers, Soldermask Bridge, Pin Holes, Soldermask to Track, 
Missing Soldermask 
Silkscreen 
Silkscreen to Soldermask, Minimum Soldermask Width 
NC Data Layer 
Overlapping Hits, Coincidental Hits, Redundant Hits, Drill to Drill, Imploded Arcs, Imploded 
Path, Mill Tab Errors 
Netlist Compare 
Import External Netlist, Extract CAM Netlist, Run Netlist Compare 

检查描述： 
SIGNAL LAYER 和 POSITIVE PLANE 检查 
Track to Track – 邻近的 traces 之间要求的最小间距 
Track to Pad – trace 和 pad 之间要求的最小间距 
Pad to Pad -邻近的 pads 之间要求的最小间距 
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Pad to Drill - 环孔 - 检查 pad 是否在指定数量的一定大小的钻孔周围有一个环孔 
Minimum Track – trace 所允许的最小宽度 
Minimum Pad – pad 所允许的最小尺寸 
Unplated Drills to Copper – 检查在选定的铜（皮）层上，是否有一些裸露的未镀铜的钻孔

和一些铜皮数据 (traces, planes, 等等) 相距太近。 
Plated Drills to Copper - 检查在选定的铜（皮）层上，是否有一些裸露的镀铜的钻孔和一些

铜皮数据 (traces, planes, 等等) 相距太近。 
Copper to One-Up-Border – 铜皮和板框之间的最小间距。 
Redundant Pads – 检查层叠的 pads 
Plated Drills without Pads – 检查在选定的层上，是否有裸露的镀铜的钻孔。 
Pads without Drills - 检查在选定的钻孔层上，是否有缺少钻孔的通孔 pads 
Antennas – 检查是否有 trace 的终点重叠到 flashed pads 
Minimum Gap – 检查铜皮区域的最小间隙，包括相同的多边形和空白区域 
Minimum Width – 检查所有铜皮区域的最小宽度，包括 traces 和灌铜区域。 
Acid Traps – 检查是否有酸可能残留造成蚀刻的地方。 
Copper Slivers – 检查是否有一些过于细长并有可能脱落的铜皮。 
Pin Holes – 检查铜皮区域内是否有微小的空间（可能造成 acid traps 或光阻剂脱落）。 
  
NEGATIVE PLANE 检查 
Plated Drills to Copper – 检查在选定的负片层上，是否有一些裸露的未镀铜的钻孔和一些铜

皮数据 (traces, planes, 等等) 相距太近。 
Unplated Drills to Copper - 检查在选定的负片层上，是否有一些未裸露的镀铜的钻孔和一些

铜皮数据 (traces, planes, 等等) 相距太近。 
Pads to Drills - 环孔 -检查 pad 是否在指定数量的一定大小的钻孔周围有一个环孔。 
Copper to One-Up-Border – 负片层上的铜皮和板框之间的最小间距。 
Isolated Thermal – 检查连接到铜皮层的每一层是否有效，或者被邻近的数据压缩而和 plane 
层上其它的部分隔离开。 
Starved Thermal – 检查每一个连接到铜皮层的热焊盘是否有效，或者被邻近的数据压缩。 
Thermal Conflict – 检查是否有 padstack 和多个负片层联系在一起 
Tie Width – 检查是否有热焊盘 relief tie 太小。 
  
SOLDERMASK 检查 
Pad to Mask – 环孔 – 检查 mask 层是否在指定数量的 pad 周围有一个环孔。 
Drill to Mask - 环孔 - 检查 mask 层是否在指定数量的一定大小的钻孔周围有一个环孔。 
Mask Slivers – 检查是否有过于细长并有可能脱落的 soldermask 区域。 
Soldermask Bridge – 检查是否有 mask 打开的地方，那样会把铜皮裸露出来，如果相距太近，

可能在锡焊时会造成桥接。 
Pin Holes – 检查铜皮区域内是否有微小的空间会造成光阻剂脱落。 
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Soldermask to Track – 检查和电气层相对的 solder masks 以检测是否有一些区域中的 mask 
被打开，如果模版移动而裸露出线路。 
Missing Soldermask – 检查选中的层中的 SMT pads 是否有一些 soldermask 被打开。 
  
SILKSCREEN 检查 
Silkscreen to Soldermask – 检查 silkscreen 是否会干扰 solder mask 层的开口。 
Minimum Silkscreen Width – 检查 silkscreen 中是否有一些过于细小的线宽。 
  
NC DATA LAYER 检查 
Overlapping Hits – 检查是否有两个钻孔太接近 (它们之间没有足够的间距)。 
Coincidental Hits – 检查在同一位置是否有两个或多个钻孔 (同样尺寸) ，却使用不同的工具

制作。 
Redundant Hits – 检查在同一位置是否有两个或多个钻孔，使用相同的工具制作。 
Drill to Drill – 检查两个钻孔之间所允许的最小间距。小于此间距的钻孔都会被标记出来。 
Imploded Arcs – 检查 mill 路径中是否有小于 mill 工具的半径（做不出来）。 
Imploded Path – 检查对工具来说过于细长的路径，以及横跨它自身的路径。 
Mill Tab Errors – 检查那些被到点的补偿缩短的线段，mill tab 不能适合它。 
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运行 Stream 
  
Checks 标签中有一个 Run 图标 (绿色图标) 显示出一个下拉列表，其中有四个可用的选项

以执行 Stream Rules 检查。 
Run 选项中可以执行在 Stream 细节说明中使用检查区域定义中定义的 Stream 。 
Run One-Up Border 选项中可以执行在印制电路板框内定义的区域的 Stream，忽略 Stream 
中定义的检查区域。 
Run Entire 选项中可以执行在整个 CAM350 环境中的 Stream，忽略 Stream 中定义的检查区

域。 
Select and Run 选项中可以执行在矩形窗口中交互定义的 Stream，忽略 Stream 中定义的检

查区域。 
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Area Check Regions 
  
Area Check Regions 可以被定义并被用于 Stream Rules checks 检测的限制区域。Stream 对话

框中的 Areas 标签允许用户创建区域并为它们命名（在层类型检查中区别并使用）。检查

区域被定义为矩形区域或印制板的板框区域。 
 
在层类型检查的 Check Region 这一行，可以在复合层中（正片或负片）组合已定义的区域，

用来为执行 Stream Rules check 创建复杂区域。 
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分析 Stream 结果 
 
Stream 对话框中的 Results 标签显示了 Stream 执行后检测到的错误。一个 Stream 多次执行

后的结果会保留下来，并以日期和时间标记出来。结果会显示为树状结构，并以执行时间，

层检查类型和检查程序类型来分类。可以在树状结构中选择一个或多个错误，或者在错误

分组中选择一个或多个错误。点击鼠标右键，可以选择删除命令，设置忽略状态，自动修

复或对错误作注释。从列表中删除的错误会隐藏，在执行的时候会显示并报告出来。有忽

略状态的错误在以后执行同样的 Stream 时不会检测出来。可以对 Stream 检测到的一些错

误类型执行修复。错误上可以添加注释来生成错误处理文件。 
 

www.ChinaAET.com电子技术应用



 

 
- 40 - 

 

 
 
直方图 Chart 会调出直方图对话框，其中显示了选中错误的概要。X 轴显示出有多少个错

误类型的错误组。Y 轴显示出错误组中错误的数量。鼠标在对话框中移动时，会显示出每

个直方图中错误的概要，包括错误类型，错误距离和每个距离内的错误数量。在直方图中

点击就可以选中对应的错误。在直方图中点击鼠标右键，可以对选中的错误执行相应的命

令。 
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Stream 结果报告可以用于显示，排序，保存或打印 Stream 规则检查结果。 
 
 

 
 

 
 

结构分析设计 
 
 

Acid Traps 
 
Acid trap （蚀刻缺陷）是在一个位置上，由于蚀刻的表面张力，酸液会残留在一个区域内。

这些酸液会造成蚀刻过度，损害生产。这个命令可以检查设计中潜在的蚀刻缺陷，这样就
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可以在板子制作前就发现这些问题。 
 

Copper Slivers 
 
Copper Slivers 是铜皮内的一些铜皮条过于窄小，有可能会造成脱落。这个命令可以在板子

制作前，在设计中的电气层和复合层中检查这些潜在的铜皮条。 
 

Mask Slivers 
 
在 solder mask 层中的铜皮条如果过于窄小，也很可能会脱落。这些脱落下来的铜皮会到处

飘荡，可能会掉落到以后需要焊接的区域内。造成的结果：坏板。这个命令可以在板子制

作前，检测设计中这些潜在的铜皮条。 
 

Find Solder Bridges 
 
创建 mask 层时，pads 的开口可能被放大的太大，从而和邻近的线路或其它导体相隔的太

近。因此，在做板时，这个 pad 的铜皮有可能和邻近的物体相隔太近而造成桥接。焊接桥

接一般都时在设计时，由于不恰当地创建 mask 而造成的。CAD 系统对这些错误时无能为

力的。快速地查找焊接桥接可以找到这些错误并在制板前修复它们。 
 

Find Pin Holes 
 
Pin hole 是实心铜皮区域内的一个空间，本来不应该存在。它可能造成酸液残留并过度蚀

刻周围的铜皮（和 acid trap 一样），或者造成光阻剂脱落，产成潜在的传导问题。Pin holes 
一般是由于不精确的 CAD 系统绘制矢量画图数据时，在层上的重叠图像间或其它数据间

留下了细小空间。这个命令可以检测设计中的 pin holes，并在板子制作前发现这些问题。 
 

Starved Thermals 
 
许多设计中都存在热焊盘的问题，比如 CAD 系统不能“真实地”表示输出到 Gerber 中的

内容，或者不能进行 DRC 校验热焊盘是否和铜皮层有良好的连接。Starved thermal 分析会

校验每一个热焊盘和铜皮层的连接是否有效，或者这些连接是否被邻近的数据压缩而相隔

太近（或重叠）。 
请注意：这个命令可以对原有的热焊盘光圈查找 starved thermals，也可以对用户自定义的

热焊盘光圈（使用线，圆，等定义，和原有的热焊盘很接近）进行查找。 
 

Isolated Connections 
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许多设计中也有电源（地）层的连接问题，比如 CAD 系统不能“真实地”表示输出到 Gerber 
中的内容，或者不能进行 DRC 校验 plane 层是否和铜皮层有良好的连接。孤立的连接命令

可以校验每一个 plane 和铜皮层的连接是否有效，或者被邻近的数据挤压而造成的和 plane 
层的其它部分隔离开的问题。 
请注意：这个命令可以查找实心铜皮连接和热焊盘中是否有孤立的连接，既包括原有的热

焊盘光圈，也包括用户自定义的热焊盘光圈（使用线，圆，等定义，和原有的热焊盘很接

近）。 
 

Thermal Conflicts 
 
这个功能可以检查使用的 padstacks，查看它们是否连接到多个负片层（查找包含多个热焊

盘的 padstacks ）。可以使用 Info/Find/Padstack 来查找 padstack。 
 
执行这个命令前，请确认在 Layer Table 中层的设置时正确的。 
 

Silk to Solder spacing 
 
Silk to Solder 会执行从 silkscreen 层到 solder mask 层的检查，查找 silkscreen 是否干扰了 
solder mask 层的开口。这种情况会污染 pad，导致许多不正确的焊接电镀。 
 

Soldermask to Trace Spacing (Trace Coverage) 
 
这个命令可以针对电气层来比较 solder masks，检查在模版移动时，是否有 mask 开口的区

域会暴露出线路，从而导致和 Solder Bridging 相同的焊接问题。 
 

Check Mill 
 
Check Mill 会分析查找 NC 层中的补偿 mill 线路问题，比如 Imploded path，或者 mil tab 问
题。 
 

• Imploded Arcs 的半径小于 mill 工具，不能被切出来。根据圆弧的补偿说明，圆弧的

半径可以减小。如果补偿大于圆弧的未补偿的半径，圆弧就会 implode （内爆）- 半
径会变成负片。 

 
• Imploded Path 问题一般是由于不恰当的补偿和 mill 工具尺寸引起的。这样形成的线

路对工具来说太窄小，横跨了它自身。比如，如果一个真正的圆弧在给定情况下内

爆，同样半径的一小段圆弧也会横跨它自身。 
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• 对 mill tabs 的 Mill Tab 错误检查，针对那些 mill tab 不能作用的太短的线段的点而

作出补偿的线段。通常，这会导致 tab 移动到最接近的顶点，但是结果是不可预测

的。 

 
Check Drill 
 
Check Drill 分析 NC 层中钻孔信息方面的问题，比如，钻空间太接近，同一位置多个钻孔。 
 

• Overlapped Drill Hits 是两个钻孔碰到了一起（它们之间没有间距） 
 
• Coincident Drill Hits 是同一位置有两个或多个钻孔（同样尺寸），但是用不同的工

具制作 
 
• Redundant Drill Hits 是同一位置有两个或多个钻孔（同样尺寸），但是用相同的工

具制作 
 

• Drill Hole to Drill Hole Clearance 是两个钻孔之间所允许的最小间距。任何小于此间

距的钻孔都会被标记出来。 
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Design Rule Checks 
 

 
Track-Track  
 
邻近线路间的最小要求间距。 
 

Track-Pad  
 
Trace 和 pad 之间的最小要求间距。 
 

Pad-Pad  
 
邻近 pads 间的最小要求间距。 
 

Outline (Older DRC screen only) 
 
任意对象和板框间的最小间距。 
 

Copper to one-up Border (Streams only) 
 
用户自定义的板边和任意层上的铜皮间的最小间距。 
 

Minimum track width  
 
Trace 所允许的最小宽度。 
 

Minimum pad  
 
Pad 所允许的最小尺寸。 
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Redundant pads  
 
检查同一位置是否有多个 pads。 
 

Pad-Mask  
 
检测 pad 和相关的 soldermask 间距之间的距离。 
 

Drill-Mask  
 
检测钻孔和相关的 soldermask 间距之间的距离。 
 

 
Drill-Pad Check (Annular ring) 
 
检测 pad 和钻孔之间的距离。在负片层上，pad 是内径的热焊盘。 
 

Antenna Detection 
 
查找没有终点的 traces。 
 

Missing Soldermask 
 
确认所有的 smt pads 都有相应的 soldermask 间距。 
 

Tie Width 
 
检测负片层上热焊盘的连接宽度。 
 

Minimum Silkscreen Width 
 
检测丝印层上线的宽度。 
 

Plated Drills w/o Pads  
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检测层中是否有一些没有相关 pad 的镀金钻孔。 
 

Pads w/o Drills  
 
检测选中的层中是否有缺少钻孔的 pad。 
 

Plated Drills to Copper  
 
检测在选中的铜皮层中，是否有裸露的镀金钻孔和铜皮数据（traces,planes,etc）相隔太近。

可以在文本框中指定要检查的最小间距。 
 

Unplated Drills to Copper  
 
检测在选中的铜皮层中，是否有裸露的未镀金的/漂浮的钻孔和铜皮数据（traces,planes,etc）
相隔太近。可以在文本框中指定要检查的最小间距。 
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其它功能 
 
 

Compare Layers 
 
这个命令允许您比较两个单独的 Gerber 层，并检查它们之间的差异。这实际上就像是把两

个层打印到菲林上，然后把一个层放到另一个层的上面，检查它们是否吻合。 
 
精确度就是在两个层之间每个像素可以偏离的公差。这个值越小，参与比较“测试”得到

的数据就越精确，系统比较层之间的差异所花的时间也越长。 
 
错误的大小，就是要把哪种差异的等级显示为错误。您可以决定只显示大于指定大小的差

异。把“加工过”的 Gerbers 和原始 Gerbers 做比较时，经常是这种情况。 
 
在比较一个设计的修订版本 A 和修订版本 B 时，这个命令非常有用。把数据从设计者传送

到生产者时，也可以用这个命令比较差异。 
 
 

Teardrop 
 
泪滴可以使走线和焊盘平滑连接。它也可以加强走线和焊盘的结合度，防止钻孔破坏连接。

这个命令也可以删除泪滴。 
 
如果泪滴违反了 DRC 规则，就不能加上去。要改变 DRC 的值，可以先选择 Analysis / DRC，
改变规则，选择 OK，再运行 Teardrop。 
取消选择 Apply DRC To Teardrop 选项，可以关闭 DRC 检查。 
 
提示：先运行 Netlist Extract （提取网表）将会允许在同一个焊盘上有重叠的焊盘，因为 DRC 
会把它们当作相同网络的一部分。 
 
Line Offset Multiple 文本框允许设置从焊盘出来的距离（沿着走线），泪滴会从1.0开始，

这意味着从焊盘边缘到泪滴的终点的距离，等于使用的线自身的 D 码的一倍直径。每增加

一个整数将会把泪滴的终点从焊盘向远处移动（使用的D码的）一个半径。也可以输入分

数来精确控制泪滴的长度。长泪滴造成的走线和焊盘之间的间隙会被自动填充。 
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Clear Silk 
 
Clear Silkscreen 命令用于从可焊接的区域中去掉丝印数据。 

点击 Silkscreen Layer 和 Solder Mask Layer 按钮，选择要操作的层。Silkscreen Layer 就是要

从中去掉丝印数据的层。Solder Mask Layer 就是包含要清除的区域的层。最好的选择是 
Solder Mask，但是也可以使用其它的层。 

输入需要的 Clearance（间隔）。这是 Solder Mask Layer 上的外形和丝印数据之间的距

离。如果使用的是实际的 solder mask，这个值可以是 0.0。但是如果使用的是焊垫本身，

那么就需要 5 mils 或更多。 

输入 Min Stub Length。如果丝印数据被好几个接近的焊盘切割开，在焊盘之间会留下小的

碎片。Min Stub Length 就是留下的最小尺寸。小于这个值的线段都会被删除。 

Clear Silkscreen 只清除 flashed pads。如果有一些 drawn pads，需要先运行 Draw to 
Flash 。 

Fast Array Module 

Fast Array Module 会自动处理小板。可以使用自动步进模式，或者使用 spreadsheet (电
子数据表格)模式，在一块大板上组装小板。在自动模式时，输入使用的 panel size（板

子尺寸），程序会以指定的空间要求，最优化方式排列可能的组装形式。也可以使用 
spreadsheet 模式，其中允许单独布置一个板子和旋转它。 
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图 1 显示了尺寸的设置。在这里指定板子的尺寸，边框的尺寸，以及边框之间的距离。

CAM350 会自动计算出板子的数量，见图 2。这些板子可以在 spreadsheet 模式中成组或

单独旋转。 

反过来，也可以指定板子的数量和板子之间的距离，然后 CAM350 可以计算出板子的

尺寸。请见图 2。 

 
图 1. 

 

 
图 2. 
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Buried and Blind Via Technology 
 
为了提取正确的网表做分析，比如 DRC 和 DFF 来检查钻孔层，必须对每一个盲/埋孔层作

出层设置。层设置在 Tables/Layer Sets 中定义。 
有两种类型的技术需要进行这些层设置： 
 

• 埋/盲孔技术。钻孔层被指定为要穿过的层。 
• MCM 技术。定义 stackup，包括绝缘层。 
 

下面是一个埋孔设置的例子。右边是层设置 1 中包含了 4 个层。下面是穿过这些层的 drill 
data。左边是通孔类型的钻孔，穿过整个板子。每一个层设置都是这样定义的，在这里可

以决定 CAM350 中板子的连同性。  
 
 

 
 
 

Edit 命令 
 

CAM350 中的大多数编辑功能都可以在编辑命令中实现： 
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• Move（移动） 
• Copy（复制） 
• Delete（删除） 
• Rotate（旋转） 
• Mirror（镜像） 

 
所有这些编辑功能都使用同样的命令结构。 
 

 
 
在选择数据时，Cmp, Drw, Flsh, Drill, 和 Mill 都可以是全局过滤器。过滤器按钮中有更详

细的过滤选项。 
 

 
 
点击这个屏幕中的 Dcode filter 可以选择特定的 Dcodes。 
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所有这些编辑命令都包含这些过滤器，并且允许用户实现从层的级别到特定的 Dcodes 的过

滤。使用这个窗口和一个/多个选择命令，用户可以选择编辑具体的特性。 
 

 
 

• 点击一个特性，允许用户只选择这个特性。 
• 按下 Ctrl 键不放，可以选择多个对象。 
• 按下 W 进入窗口模式，用户可以在窗口中选择多个对象。 

 
 

• “I” 命令决定选择是在窗口外部还是内部。 
• “C” 命令决定是否选择那些接近选中窗口的对象。如果不选择这些接近的对象，那

么只选择整个窗口内的对象。 
 

注意： CAM350 有动词/名词界面。这意味着先选择要执行的命令，再选择要编辑的对象。 
 
 
 

Change Dcode 
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选择 Edit /Change /Dcode 光标变为对象捕捉光标。 
 
请注意：新的形状和尺寸必须存在于 Aperture list（光圈表）。 
 

1. 点击要改变的 trace 或 flash，选中的对象会高亮显示。重复选择需要的多个对象，

和/或使用过滤器选项来选择需要的对象。完成选择后，点击鼠标右键。这时出现 
Change Dcode 对话框。 

 
2. 从选择列表中选择相应的 Dcode，再点击 OK。 

 
3. 选择另一个要改变的 Dcode，或者点击鼠标右键结束命令。 

 
 

Add Flash 
 
选择 Add /Flash。当前 Dcode 的尺寸和形状会显示在光标中。 
 

1. 移动光标到需要的位置，再点击布置 Dcode。 
 
请注意：使用 Dcode 选择和层选择，层控制工具条中的命令可以改变当前 Dcode 或当前层。 
 

Add Line 
 
选择 Add /Line。线捕捉工具显示再工具条中，当前 Dcode 的形状会位于鼠标中。 
 

1. 点击选择新的线的起始点。移动鼠标到下一个顶点或结束点，再次点击。如果需要

多个顶点，可以重复这个过程。 
 

2. 点击鼠标右键完成画线。 
 

3. 在新位置点击，开始添加另一条线，或者再点击右键结束命令。 
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